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1 What is BXBdashboard 

BXBdashboard is a Business Intelligence (BI) software that improves the visualization of an 
organization, department or project performance indicators. 

Speedometers, thermometers and charts can show the business performance. 

 
Figure 1 – Dashboard sample 

2 Accessing the tool 

The user must login informing his username and password, unless when BXBdashboard is 
called by some application with the login automatically passed as a parameter. If the 
database contains more than one company, the company code must also be informed. 
 

After logging in, if you are positioned in another module, you must select BXBdashboard in 
the combo-box at the upper left corner of the screen. 
 

 

Figure 2 – Modules combo-box 
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3 BXBdashboard features 

BXBdashboard allows to: 

 Create new dashboards* 

 Configure charts and gauges* 

 Insert and remove charts and gauges from the dashboard* 

 Apply filters (on gauges, charts or on all the dashboards) 

 Drill down from charts and gauges 

 Show and hide dashboards 

 Manage the access permissions* 

 Export dashboard to .PDF and .PNG image format. 

 Send a dashboard image by e-mail 

 

3.1 Adding/opening a dashboard 

Click on the File > Open button. 

 
Figure 3 – Dashboards File menu 

If there is some previously configured dashboard available, the list of existing (and not 
openend) dashboards will be displayed. Select a dashboard and then click on Open (Figure 
4). 

 
Figure 4 – Open dashboard 

*These features are not available for Viewer edition users. 
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Note: Once you have selected the check box Initial, the respective dashboard is 
automatically displayed every time the user enter BXBdashboard. 

 

 

3.2 Creating a new dashboard 

To create a new dashboard (without any related object), click on File > New. 

 

Figure 5 – Creating new Dashboard 

 

Give the new dashboard a name. Then click on Save. 

 
Figure 6 - New Dashboard 

Once you set a name to the dashboard, the Objects screen will be displayed for you to insert 
previously configured objects (charts or gauges) on the dashboard or to create new ones. To 
insert objects in the dashboard, just check the desired ones at the column Insert in the 
dashboard and click OK. 
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Figure 7 - List of objects 

 

 

3.3 New gauges 

To create a new gauge, click on the “Objects” button. 
 

 
Figure 8 – Objects 

 

For a new gauge, click on the button New. 

 
Figure 9 – New object 

 

The Edit object screen will be displayed. 
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Figure 10 – Edit object: Gauge’s basic tab 
 

3.3.1 - Gauge’s Basic tab: 

 Cube: List of cubes that the logged in user have access permission. 

 Object type: To choose, between gauge or chart. 

 Circular or Linear: Gauge models to choose from. 

 Measure: List with measures defined at the selected cube. 

 Object name: Name of the object to be shown in the gauges list. 

 Multi tenant: this check box is offered when the respective cube is multi tenant, and 
once the check box is checked, this gauge can be shared with all the provided 
companies of this environment.  

 Minimum value: Value that determines the minimum scale of the gauge. 

 Maximum value: Value that determines the maximum scale of the gauge. 
 

3.3.2 - Gauge’s Title (to be shown above the gauge) tab: 

Title that will be displayed on the dashboard along with the gauge. It can be formed by 
up to 4 lines and the content of the first 3 lines is free for the user to define what he 
wants. The first line suggests the gauge’s measure label (that the user can keep or 
change) and the 4th (last) row the user can choose to fill with the last cube’s update 
date and time. 
 

 

Figure 11 - Gauge’s title set up form 
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3.3.3 - Gauge’s Advanced tab: 

 

Figure 12 - Gauge’s advanced tab 
 

 Number of greater scorers: Quantity desired for greater markers to separate the 
scale values. 

 Number of smaller scorers: Quantity desired for smaller markers to separate the 
scale values. 

 Decimal places (value): Sets the number of decimal places for the value of the 
gauge’s selected metric. 

 Decimal places (scale): Sets the number of decimal places for the scale of the gauge’s 
selected metric. 

 Divisor: Allows dividing the total value of the measure. 

 Show in title: Allows inserting the divisor automatically in the gauge’s title. 

 Label (Internal): Gauge’s internal label, limited to 18 characters. 

 Height x Width (pixels): Allows you to resize the gauge by changing the height and 
width in pixels. 

 Fit to mobile: If activated and using a mobile device, the gauge will ignore it’s size set 
by the user and will use the width from the mobile device as its own width. 

 Related view: If the user has access permission to BXBanalytics, it will be possible to 
associate a view for the gauge in order to navigate between the gauge and the view 
from BXBanalytics. 

 
3.3.4 - Scales tab: Options for customizing the gauge colors according to the range of values. 
 

3.3.5 - Semaphores tab: Except for semi-circle gauge, allows enabling a semaphore that 
changes its colors according to the cursor position. 
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3.3.6 - Filters tab: Allows applying persistent filters to the cube’s data, so that the gauge is 
displayed only with part of the cube’s data. 

 

3.3.7 - Access permissions tab:  

To modify or delete: allows to define whether the deletion or modification is only 
allowed for who is creating the object or can be deleted or modified by any of the 
users marked in the "To view" check boxes. 

To view: shows the list of users and the possibility of marking the respective check box 
for the user with the right to view this object. 

 

Figure 16 – Edit object: Access permissions 

After configured and saved, the new gauge will be available at the list and already checked, 
to be inserted in the dashboard. 
 

3.4 New charts 

To create a new chart, click on the Objects menu button and, into the opened window, click 
on New. Then the screen Edit Objects will be displayed. 
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Figure 11 – Edit Object: Chart’s “Basic” tab 

3.4.1 - Chart’s Basic tab: 

 Cube: List of cubes that the logged in user have access permission. 

 Object type: To choose between: 
. Chart: with the possibility to choose different formats of charts 
. Gauge: with 2 options: Circular or Linear 

 Measure: List with the measures defined at the selected cube. 

 Main dimension: The list with the dimensions defined at the selected cube will be 
displayed for the main dimension of the object. When selecting a date field with 
decomposed dates, a new list on the right will be displayed with their decomposed 
dates. 

 Secondary dimension: The list with the dimensions defined at the selected cube will 
be displayed for the secondary dimension of the object. When selecting a date field 
with decomposed dates, a new list on the right will be displayed with their 
decomposed dates. 

 Object name: To be displayed for selection in the charts list. 

 Multi tenant: Check box offered when the cube is "multi tenant" and turns the gauge 
available to be shared with other companies in the environment. 

 

3.4.2 - Chart’s Title tab: 

Title which will be displayed on the dashboard along with the chart. It can be formed 
by up to 4 lines and the content of the first 3 lines is free for the user to define what he 
wants. The first line suggests the chart’s name (that the user can keep or change) and 
the 4th (last) row the user can choose to fill with the last cube’s update date and time. 

 

3.4.3 - Chart’s Advanced tab: 



 
 QUICK START GUIDE 

 

 www.bxbsoft.com  11 
 

 
Figure 12 – Chart’s advanced tab 

 

 Data values: Allows hiding the data values at the chart. At the right, there is an 
option to set the number of decimal places (if not filled, the original definition of the 
cube will be considered). 

 Scale values: Allows hiding the scale values at the chart. At the right, there is an 
option to set the number of decimal places (if not filled, the original definition of the 
cube will be considered). 

 Value as percent: Displays the values converted into percentages. This option is 
available only for pie charts. 

 Y axis – Min: Defines the minimum value to be displayed at the Y axis. 

 Labels position: Allows choosing the position in which the legend has to be shown: 
“Right”, “Left”, “Top”, “Bottom” or “Do not show”. This property is shown only at Pie 
charts or charts using a secondary dimension. 

 Divisor: Allows dividing the total value of the measure. 

 Sorting: Options to sort, by measure or dimension, in ascending or descending order. 

 Max number of elements: Allows limiting the number of elements that will be 
displayed at the chart. 

 Show “Others”: By checking this option, the chart will show as an additional element 
the sum of the rest of the elements. 

 3D: By checking this option the chart will be transformed in a 3D model. 

 Height x Width (pixels): Allows resizing the gauge by changing the height and width 
in pixels. 

 Maintain proportion: If checked, when you change the width, the height is re-
adjusted and vice versa. 

 Fit to mobile: If activated and using a mobile device, the chart will ignore it’s size set 
by the user and will use the width from the mobile device as its own width. 

 Related view: If the user has access permission to BXBanalytics, it will be possible to 
associate a view for the gauge in order to navigate between the gauge and the view 
from BXBanalytics. 

 

3.4.4 - Colors tab: Options for customizing the chart colors. 
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3.4.5 - Filters tab: Allows applying persistent filters to the cube’s data, so that the chart is 
displayed only with part of the cube’s data. 

 

3.4.6 - Permissions Tab:  

To modify or delete: allows to define whether the deletion or modification is only 
allowed for who is creating the object or can be deleted or modified by any of the 
users marked in the "To view" check boxes. 

To view: shows the list of users and the possibility of marking the respective check box 
for the user with the right to view this object. 

 

 

 

3.5 Drill down 

You can drill down (detailing the information to the next level) both in gauges and charts. 

Clicking on a chart or gauge, a temporary toolbar is displayed whith some icons: Drill down, 
Navigation to BXBanalytics **, filter (funnel), information about the chart/gauge, edit * 
and remove (X) *. Another click on the chart or gauge hides the icons. 

 

 
 

*These features are not available for Viewer edition users. 

** Only if the user has permission for accessing views of the same cube and if 
allowed to use BXBanalytics 

 

ATENTTION 
Option "Value in percentage" is exclusive to Pie type charts. 
Option "Label position" is exclusive to Pie type charts or charts with more than two 
selected measures. 
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Figure 20 – Drill down Icon 

The highlighted icon at the illustration above displays the Drill Down screen with Dimension, 
chart type and sorting suggestion. 

 

 
Figure 21 – Drill Down settings 

Click on the specific area of the chart where you want to open details. 

 
Figure 22 – Next Level on Drill Down 
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Change the chart type to Column and click Ok. The chart is shown at the same screen of Drill 
Down. When the number of elements is very large, the top 7 are displayed and the 
remaining ones are accumulated in the element Other. The maximum number can be 
changed at the Max number of elements field. 

By clicking on a column, there’s a new drill down, allowing you to select the dimension and 
the Chart Type, which can be: column, pie, area, line or bar. 

Note: Once the user has chosen the sequence of dimensions, measures, sort orders and 
chart types at the drill down process, BXBdashboard will repeat this sequence for the 
next drill down.  

 

3.6 Drill down as worksheet 

Another way to drill down the data is through a worksheet, which will be obtained by: 

a) A drill down from the dashboard when the drill comes from a chart with two 
dimensions (if the chart in the dashboard has only one dimension, the default drill 
mode is through a chart); 

b) Selecting the “Worksheet” option at the “Show as” radio button in the Drill down 
Settings panel. 

 
Figure 23 - Drill down on worksheet 
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When selecting this option, a list of available columns will be displayed on the left side, a list 
of used columns on the right side and the sheet will be displayed below.  

To add columns at the worksheet, simply click on the green icon next to the respective 
column available. To remove a column, click the red icon in column list on the right.  

To change the display order of each column, click on the blue arrows up or down in the list 
to the right.  

To export the worksheet to a CSV file, simply click the “Export to CSV” button. The following 
screen will appear: 

 
Figure 24 – Export parameters screen 

 Column header: Check box to export the header. 

 Column delimiter: Field to inform the column delimiter. The default value is “;” 

 Text qualifier: Field to inform the text qualifier, if it is necessary. 

After setting up the desired options, simply click “OK”. 
 

To send the CSV file by e-mail, click on “Email” button and the screen below will appear: 

 

Figure 25 - Send worksheet by e-mail 
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3.7 Navigation to a BXBanalytics view 

 
Figure 26 - Navigation to BXBanalytics 

In this item, it’s possible to open a view in BXBanalytics according to the related view set in 
the edit object screen. If the user doesn’t have access permission for BXBanalytics, this item 
will not be shown. If the object doesn’t have a related view: 

a) for Viewer edition users this icon will not be shown.  

b) and a Personal or Professional edition user clicks on this icon, BXBanalytics will open with 
a list of views from the cube of the dashboard’s object or, if there are no views available, a 
new view will be opened according to the dimensions and measures selected for the object. 

 

3.8 Data infos and cube reload 
 

If the user has permission to load the cube, it’s possible to update the cube from a chart or 
gauge in the dashboard. The load permission is assigned in the module “Database”, as seen 
in the screen below: 

 
Figure 13 - Load permissions 

 

When the Cube infos icon has an “i”, it means that the user will only see the name of the 
respective cube and some information about the last cube load run, but cannot reload the 
data of the cube. 

 
Figure 30 – Without load permission 

 

If the Cube infos icon is displayed as illustrated below, it means that the user can see the 
same information and has the possibility to update the data of the respective cube. 
 

 
Figure 31 – Cubes info icon with load permission 
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Figure 32 – Cube last loading infos with reload option 

 

In both cases an info box will be displayed, but the “Start load” button will be available only 
if the user has the load permission. Clicking this button, the cube update process will start. 

 

 

3.9 Settings 

 
Figure 33 - Settings icon, for editing the object 

Clicking this icon the “Edit object” (see figure 10 or 17) screen will be opened. 

All fields can be edited as presented at the 3.3 New Gauges and 3.4 New Charts topics. 

 

3.10 Removing objects from a dashboard 
 

 
Figure 14 – Remove Object Button 

A click on the "X" icon will remove the selected chart or gauge from the dashboard. 
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3.11 Filters 

Filters can be applied to the entire dashboard or only to some gauge or chart. To apply a 
filter to the entire dashboard, click on the Filters menu and select the Ad hoc filter option. 

To apply a filter on a simple object (gauge or chart), you may click on this object and then a 
little toolbar will appear. In this toolbar click on the funnel icon and the filter screen will be 
shown. 

3.11.1 Ad hoc filter 

The filter screen will be displayed (like illustrated in the Figures 31-33), where you can select 
the column to be filtered and the selection method, as follows: 

 Range: The fields From and To can be filled with numeric values, alphanumeric data 
or dates. Clicking the button Filter. 

 Pattern: allows using the character "%" as a wildcard before and/or after the desired 
criterion. For example: filling this field with %store% for the column “Customer” and 
clicking the button Filter, all the customers that have the word “Store” in any part of 
the name will be displayed. 

 Selection List (discrete): Element by element. This option will only be shown if the 
total of items is equal or less than the quantity set in the field “Max. qty of members 
for filter list (discrete selection)”, found in the user settings. 

 
 

 
Figure 15 - Filter screen by range 
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Figure 37 - Filter screen by pattern 
 
 
 

 
Figure 38 – Filters screen by Selection list 

To confirm and conclude the operation, click on the Ok button. 
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3.11.2 Set initial filter 
 

This option allows configuring a filter (Figure 34) to be applied by opening the dashboard, 
before loading the cube’s data, where the user can use the filter window illustrated in 
Figures 40. 

 

Figure 39 – Initial filter set up window 
 

 

Figure 40 – Initial filter window for the end user 
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3.12 Exporting a dashboard to .PNG 

Option to save the selected dashboard into a PNG format file, considering the selected 
filters. To export it, just click on the Export > PNG menu option. 

 
Figure 41 – Export dashboard to .PNG 

 

3.13 Exporting a dashboard to PDF 

Option to save the selected dashboard into a PDF format file. It will also consider the 
configured filters for the dashboard. To export it, click on the Export > PDF menu option 

 
Figure 42 - Export dashboard to PDF 

and the following screen will be shown: 
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Figure 416 – Export to PDF set up screen 

In this screen it’s possible to remove and reorder the charts and gauges to be exported. If 
you want to “rescue” some removed objects or include objects newly inserted to the 
dashboard, click the “Reload List” button. 

It’s possible to choose between portrait or landscape orientation for exporting, as well as to 
define whether exporting it in the way the objects are arranged in the dashboard (by 
choosing "Dashboard image") or in a table format. If the option you select is "Table" you can 
change the quantities of table columns in the "Columns" field. 

On "Paper" field you may set the respective paper size. 

After configuring the exporting, click the “Export” button to generate the PDF file. 

 

3.14 Sending PNG by e-mail 

Option to send a picture at.PNG format from the selected dashboard to the destination e-
mail you want. To do this, simply click on the “Send by Email" button and fill in the "To" and 
"Subject" fields. 
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Figure 44 – Send dashboard by e-mail 

3.15 Permissions 

The “Permissions”button shows the users list and allows defining which users will have 
access to the selected dashboard. 

 

Figure 45 - Permissions 

3.16 Hiding a dashboard 

If you don’t want to have a specific dashboard displayed on the screen, just click on the “x” 
near the name of the dashboard, which appears on the respective tab. 

This operation transfers the hidden dashboard to the list of available dashboards which can 
be viewed, changed or deleted by clicking on the “Dashboards” button of the toolbar. 
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3.17 Renaming a dashboard 

To change the name of a dashboard, click on the “Settings” button of the toolbar. At the 
opened window, change the name and click “Save”. 

3.18 Interval for automatic update 

If you want to leave the dashboard opened on the screen with automatic data update: 

 It will be necessary to schedule the cube load/update process, preferably in the same 
interval that a screen refresh is desired; 

 The option “Settings” of the toolbar menu opens a window that also allows 
configuring how often (in minutes) the screen should have its data updated. Filling 
with 0 (zero) in this field, there is no automatic update, remaining on screen the data 
displayed on the dashboard at the time it has been opened. 

 
Figure 46 – Dashboard settings 

Note: The auto refresh process only happens on the dashboard that is being displayed 
(where the objects are being viewed). 

 

3.19 Pause for skipping dashboards 

 
Figure 47 - Pause for skipping dashboards 

The interval for skipping dashboards can be set for each dashboard, but it will work only 
when the value set in the user settings screen is different from zero. 

If the value for the dashboard is 0 (zero), it will be considered the informed value in the user 
settings screen. 


